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This is the user guide we wish had been provided, collected from the feedback of Nextube
customers. This isn't an official guide provided by Rotrics and the information provided here is
“as-is.” There are no guarantees of accuracy, and your usage of the guide conveys no liability to
the authors.

ﬁ Join the enthusiastic fans of Nextube at facebook.com/groups/197056519103446.
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Included in the box

* Nextube with six 0.96" IPS screens
6 There are two white anti-skid pads on the bottom. Peel off the thin plastic coverings before use.

» USB-A 5V/1A charger (US version shown)

Software installation

To set up your Nextube, you must download the Nextube Studio software.

1. Download Rotrics Nextube Studio at rotrics.com/pages/downloads. A Windows and
Mac desktop version is available.

2. Install the software on your computer and then open Nextube Studio. The file name for
Windows is Rotrics Nextube Setup 0.0.2.exe and Rotrics Nextube-0.0.2.dmg for Mac.

& SECURITY Your computer’s operating system might display various notices that the site,
publisher, or software is unknown, untrusted, or potentially malware. To this date, no one has
reported an issue. However, installing the software remains at your own risk.

Windows: Click Run, Run Anyway, or Allow. For more information, see Windows help.

Mac: Open System Preferences, go to Security & Privacy, and then allow the app to be
installed. For more information, see Mac help.

Linux customers

Although unsupported, the Windows version of Nextube Studio can be used with Wine for
Ubuntu. Customers report that USB connections don't work, but Wi-Fi does.
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Initial connection setup

There are two ways to initially set up your Nextube — wired USB (recommended) or wireless.
I CONNECTION METHOD 1 — Wired USB (recommended)

6 If you use the wired USB option for initial setup, you can enter your Wi-Fi network information so that all
subsequent changes in Nextube Studio are made via a Wi-Fi connection. Customers report fewer issues
when using the initial wired USB connection method.

1. Using the supplied USB-A to USB-C cable, connect your Nextube to a USB connector on
your computer. Don’t use a USB-C to USB-C cable.

2. In Nextube Studio, in the upper-left corner, click E3N connect.
The Connect Nextube dialog box appears.

3. Click Serial Port.

4. Click in the Choose a port box, and then click the COM port.

6 Multiple COM ports might appear. Try clicking one. If the blue Connect button turns gray and
Disconnect turns blue, your Nextube is connected. If this doesn't happen, try another COM port
until Nextube is successfully connected.

The [=51 Connect button on the upper-left of the Nextube Studio window should appear
orange to indicate connected.

5. On the Connect Nextube dialog title bar, click X to close the dialog box.
Optionally, enter your Wi-Fi information
1. In Settings, click Wi-Fi Network.

2. Enter your Wi-Fi (SSID) name and password. The Wi-Fi network name and password are
both case-sensitive.

6 Nextube only supports 2.4 GHz 802.11 b/g/n Wi-Fi networks. Most newer routers support both
2.4 GHz and 5 GHz. Older single band routers are typically 2.4 GHz.

3. On the Settings title bar, click X to close the Settings dialog box.
4. In the upper-right, click IEZZZM.
Your Nextube will update and connect via your Wi-Fi network.

Your Nextube clock is calibrated automatically by using NTP (network time protocol)
and a RTC (real time clock) chip. The time will synchronize to the computer time after
about 30 seconds to 5 minutes.
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CONNECTION METHOD 2 — Wi-Fi AP

1. Using the supplied USB-A to USB-C cable, connect your Nextube to the supplied USB
power adapter and plug the power adapter into an electrical outlet.

2. Onyour computer or mobile device, open Wi-Fi settings and connect to the network
name (SSID) nextube-ap-xxxxxxxxxxxx where xxxxxxxxxxxx is the MAC address.

3. Enter 12345678 for the password.

A web page should open in a web browser. If it doesn’t, open your web browser, and then
in the address bar, enter http://10.10.10.1 to open the Nextube configuration page.

4. Select the name of your Wi-Fi network, and then click Next.

9 Nextube only supports 2.4 GHz 802.11 b/g/n Wi-Fi networks. Most newer routers support both
2.4 GHz and 5 GHz. Older single band routers are typically 2.4 GHz.

5. Enter your Wi-Fi network password, and then click Apply.
6. In Nextube Studio, in the upper-left corner, click Connect.
The Connect Nextube dialog box appears.

7. Click Wi-Fi.
How do I find my Nextube IP address?

8. Click +to open the Wi-Fi connect

manually dialog box. Log in to your Wi-Fi router and look for the DHCP lease and
IP address for the device. Nextube usually appears with a
9. Enter the IP address of your hostname containing nextube. Each router is different, so

Nextube and then click Confirm please refer to your router's manual for more instructions.

Onthe C N be dialog b There are also apps for Windows, Mac, Android, and iOS
) n the Connect Nextube dialog box, that can help identify devices on your Wi-Fi network. Fing is
if the blue Connect button turns gray  a free app available for both Windows and Mac desktops,

and Disconnect turns blue, your as well as Android and iOS mobile devices. Download Fing
Nextube is connected. at fing.com/products/fing-app.
The [250 Connect button on the

upper-left of the Nextube Studio window should appear orange to indicate connected.
10. On the Connect Nextube title bar, click X to close the dialog box.
11. In the upper-right, click IEZEZM.

Your Nextube will update and connect via your Wi-Fi network.

Your Nextube clock is calibrated automatically by using NTP (network time protocol)
and a RTC (real time clock) chip. The time will synchronize to the computer time after
about 30 seconds to 5 minutes.
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Customize your Nextube

Changes are uploaded to Nextube via a wired USB connection with the included USB cable or a
Wi-Fi connection if you set it up in the Initial connection setup section.

WI-FI CONNECTION

6 You should have already configured your Nextube Wi-Fi configuration. If not, go to the Initial connection
setup section first.

—

Using the supplied USB-A to USB-C cable, connect your Nextube to the supplied USB
power adapter and plug the power adapter into an electrical outlet.

2. In Nextube Studio, in the upper-left corner, click E=N connect.
The Connect Nextube dialog box appears.
3. Click Wi-Fi.

4. Click the +icon to open the Wi-

i ?
Fi connect manually dialog box. How do | find my Nextube IP address?

5. Enter the IP address of your Log in to your Wi-Fi router and look for the DHCP lease and
IP address for the device. Nextube usually appears with a
hostname containing nextube. Each router is different, so
please refer to your router's manual for more instructions.

device, and then click Confirm.

On the Connect Nextube dialog
box, if the blue Connect button There are also apps for Windows, Mac, Android, and i0S

turns gray and Disconnect turns that can help identify devices on your Wi-Fi network. Fing is
blue, your Nextube is connected a free app available for both Windows and Mac desktops,
! ) as well as Android and iOS mobile devices. Download Fing

The [=21 Connect button on the at fing.com/products/fing-app.
upper-left of the Nextube Studio

window should appear orange to

indicate connected.

6. On the Connect Nextube title bar, click X to close the dialog box.
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I WIRED USB CONNECTION

1.

Using the supplied USB-A to USB-C cable, connect your Nextube to a USB connector on
your computer. Don’'t use a USB-C to USB-C cable.

In Nextube Studio, in the upper-left corner, click Connect.
The Connect Nextube dialog box appears.

Click Serial Port.

Click in the Choose a port box, and then click the COM port.

6 Multiple COM ports might appear. Try clicking one. If the blue Connect button turns gray and
Disconnect turns blue, your Nextube is connected. If this doesn't happen, try another COM port
until Nextube is successfully connected.

The [21] Connect button on the upper-left of the Nextube Studio window should now
appear orange to indicate a connected.

On the Connect Nextube title bar, click X to close the dialog box.
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Set clock mode

In Nextube Studio, there are three clock modes for the default clock app.

Mode Clock type Display

102957 24-hour clock Hours | Minutes | Seconds
10:29 A/P 12-hour clock Hours | Minutes | AM/PM
10:29 Alt 24-hour clock Hours | Minutes | Information

v
102957 10:2907  [I0R290M0E [ &

If you use 10:29 Alt, there are additional options that can be set.

» Weather conditions

» Week/Date

* Indoor High/Low temperature

= Current temperature

» Display duration of each information item

1. Click the display format that you want.
2. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click 2.

Your Nextube updates and restarts.

Set clock style

6 To use custom created styles that you've created or downloaded from other customers (for example, in
the Facebook group), see the Custom clock styles section.

The default Clock app can be customed with 12 different display character sets that are
included with Nextube Studio.

1. Click the Nextube illustration to open the Pick your style dialog box.

Pick your style

OBRCR 1o8 ¥ Jopoy yoye
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Click one of the character styles.
On the Pick your style title bar, click X to close the dialog box.
With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click IEZZN.

Your Nextube updates and restarts.

Set display brightness

1.

2
3.
4
5

In the upper-right of Nextube Studio, click EEEES.

Click Screen Brightness.

Click on the Screen Brightness bar to set the brightness level between 0 and 100.

On the Settings title bar, click X to close the Settings dialog box.

With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click 2=,

Your Nextube updates and restarts.

Set backlight

Each Nextube tube contains a LED backlight on the rear side of the side. These backlights can
be used to provide ambient background lighting as an enhancement to your Nextube.

In addition to Off, there are four backlight settings.

Solid

Breathing (about a one-second interval)

Marquee (set the LED color of each tube and the color changes in a loop one by one)
Neon (the LED color will be random)

The Solid, Breathing, and Marquee options allow you to specify the color.

1.

2
3.
4

In the upper-right of Nextube Studio, click EEZZ.
Click Backlight.
Select the backlight type.

If you selected the Solid, Breathing, or Marquee options, click on one of the six default
base colors. Choose any color by clicking on the color palette.
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5. On the Settings title bar, click X to close the Settings dialog box.
6. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click 2.

Your Nextube updates and restarts.

Set weather configuration

1. In the upper-right of Nextube Studio, click EEEEA.
2. Click Weather Config.
3. For Location, enter a city name.

J

A bug exists where multiple cities appear without unique state or districts. For example, “Dallas’
shows repeated “Dallas, US" entries. You must find the correct entry for your location.

4. For Temperature Format, select °F or °C.

5. On the Settings title bar, click X to close the Settings dialog box.

6. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click IEZ=N.
Your Nextube updates and restarts.

9 The city name isn't saved. If you enter the Weather Config settings later, you must re-enter the city.

Set volume

1. In the upper-right of Nextube Studio, click EEZIES.

2. Click Sound.

3. Click on the Sound bar to set the volume level between 0 and 100.

4. On the Settings title bar, click X to close the Settings dialog box.

5. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click IEZ.

Your Nextube updates and restarts.

Install apps

There are seven apps provided in Nextube Studio. Rotrics has said that additional apps are
planned in the future. Up to 16 apps can be installed at any time on your Nextube.

The apps include the following:

» Clock — The default Nextube clock.
» Custom Clock — Clocks that you can customize with your custom styles.
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* Pomodoro Timer — A timer that you can start using the buttons on Nextube.
= Timer — A pre-defined time duration.

= Subscribe — Currently, supports subscriber counts for a YouTube channel.

»= Alarm — An alarm clock function.

= Album — Display your own pictures on Nextube.

1. Inthe top-center of Nextube Studio, click to open the App Library.

To add an app, click and drag the app icon to the dock below the library.

To re-arrange the order of the apps, click an app icon in the dock and drag it left or right.
To remove an app from the dock, right-click the app icon, and then click Delete.

On the Settings title bar, click X to close the Settings dialog box.

o o~ L N

With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click 2.

Your Nextube updates and restarts.

Select app on Nextube

One app at a time can be displayed on your Nextube.

= To switch between apps, press the first or third button to display the previous or next
app, respectively.

| |

|
|

/a® i ) b

Lo

6 If your apps use the same display style, the switching time between apps is minimized. Using different
display styles for loaded apps increases the time to switch apps.
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Custom clocks

Up to five custom clocks can be uploaded to your Nextube. Customers are sharing custom
clock styles in the Nextube Facebook group files section.

facebook.com/groups/197056519103446/files/docs

6 Want to design your own custom clock styles?
See the Create custom clock style graphics section.

Preview of clock styles
See available clock styles, including the Nextube default styles and customer created files for custom clocks.

https://docs.google.com/spreadsheets/d/18NGcr-SCZzCia6doiqDfmKMfYdIrEh2eHhnPBDkqfW8

Nextube clock styles
Facebook group:
https:fwww.facebook.com/groups/197056519103446

To insert an image, click in the cell, and on the Insert menu, click image > Insert image in cell.

Creator/Uploader Sample Width/Height Notes

ATAT

P 1% ] i A - \
W' W T Wit W BT B

nk

link 1
(Facebook) 80x160

Frontage Will Austin

N 11405326
Gotham Robert Deckman (Facebook) | | | | | 80x160

WAL WL L A A

F; V2 F; ‘
| e
(Facebook) ,I H rl I I 80x160

link

HP41 3 Paul Grace
g, W W W W L .
link Popular replacement for the Clock
Nixiefied Scott Dau {Facgook} B80x160 defan.xlt style. More accurate look to
a nixie tube
s B W 4
- | 4
Nixiereal 2 Paul Grace (Facebook) L.l |& | | oL 980x2485
g ol WA BT W BT BT B
L oy

Numechron-ish Paul Williams link (Dropbox) I& 'ﬁ IH .’5 [E 300x300
| Jo— J et
i W W BT W \

300x300
— Y S NGRY e ¥

link
(Facebook)

Y. . .w.mf‘____,mmuak

Numitron Will Austin
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To use a custom clock style from the Facebook group, download the file to your computer and rename
6 the file extension (usually .zipper) to .zip (due to Facebook file upload workaround). For .tgz files, the free
7-Zip app available at 7-zip.org will open the compressed file.

To install a custom clock style, do the following:

1. Inthe .zip or .tgz file, extract the folder containing the files to a location on your
computer like the Desktop or the Downloads folder.

In the top-center of Nextube Studio, click to open the App Library.

Click and drag the Custom Clock app icon to the dock below the library.

To re-arrange the order of the apps, click an app icon in the dock and drag it left or right.
To remove an app from the dock, right-click the app icon, and then click Delete.

Click the Custom Clock app icon in the dock.

N o g > 0D

There are two clock modes available for the Custom Clock app. Select a clock mode.

Mode Clock type Display
102957 24-hour clock Hours | Minutes | Seconds
10:29 A/P 12-hour clock Hours | Minutes | AM/PM

8. You must add a new icon for each digit, colon, blank, AM, and PM. Start by clicking
anywhere on the Nextube illustration.

The Custom Clock dialog box appears.

Custom Clock ([

A background image
for blinking colon
effect

9. Click one of the characters.

The Adjustment dialog box appears.
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Adjustment

80 x 160 px

O

0 Height

0

10. Open the folder on your computer that contains the custom fonts and then drag the
corresponding .jpg graphic file to the gray box in the Adjustment dialog box.
Alternatively, click the gray box to open a file browser window, and then select the file.

11. Graphics that are 300x300 with the clock face image correctly placed within the image
shouldn’t require adjustment and you can go to step 12.

Image files that are 80x160 require adjustment. Click in the Width box, replace the value
with 40, press Tab twice, enter 0 (for Move X), press Tab, enter 0 (for Move Y). It's
important that you use Tab twice after entering the Width instead clicking to other
boxes.

9 The software changes your Height and Width values as you tab ending with the
correct values of Width of 80 and Height of 160.

Images of other dimensions must also be adjusted for scale and positioning.
12. Click Confirm.
13. Repeat steps 9-12 for each of the other digits, colon, etc.

6 There are two images for the colon — a blank image and the image of the colon.
Nextube switches between the two images. If you don't want the colon to “blink,”
select the colon image for both blank and colon.

14. On the Adjustment title bar, click X to close the dialog box.
15. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click .

Your Nextube updates and restarts.
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I DEFAULT CLOCK STYLE FILES

The graphics for the default 12 styles available for the Clock app are saved on your computer.
Note that modifying these files won't change your Nextube display. For custom clock displays,
you must use the Custom clock app and use your own image files.

Windows

c:\Users\username\AppData\Local\Programs\rotrics-
nextube\resources\static\data\images\themes

Mac

Go to Applications and right-click on the Rotrics Nextube app. Click Show Package Contents.

\Applications\Rotrics
Nextube.app\Contents\Resources\static\data\images\themes

Export custom clock

To install a custom clock style you need the graphics files. If for some reason, you've lost the
original files, it's possible to export them if installed on your Nextube.

1. Inthe apps dock, click the Custom Clock you want to export.

The Custom Clock dialog box appears.

Custom Clock (/7]

BECHEECERHEERA

A background image
for blinking colon
effect

2. Click ¥4
3. Enter a file name and save the compressed .zip file to your computer.

The exported images will have degraded quality from the original upload and an image
dimension of 80x160.
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App: Pomodoro Timer

This timer is based on the Pomodoro Technique, a time management method developed by
Francesco Cirillo. Derived from the Italian word for tomato, each interval is known as a
pomodoro. Why a tomato? Cirillo used a tomato-shaped timer as a student.

A task or interval (25 minutes) is followed by a short break (5 minutes). After the defined
number of intervals (usually 4), there’s a long break (15 minutes). The pattern then restarts.
Although these are the standard values, you can customize them in Nextube Studio.

1. In the top-center of Nextube Studio, click Il to open the App Library.

2. Click and drag the Pomodoro Timer app icon to the dock below the library.
3. Inthe tray, click the Pomodoro Timer app icon.
4

Click to open the Pomodoro Settings dialog box.

. Pomodoro Settings

Duration 25 min
Short Break 5 min
Long Break 15 min
Intervals 4

5. Set the Duration, Short Break, Long Break, and Intervals settings.

6. On the Pomodoro Settings title bar, click X to close the dialog box.

7. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click IEZZN.

Your Nextube updates and restarts.
To use the app, when selected on your Nextube:

= A short press of the middle button starts and stops the timer.
= Along press of the middle button resets the timer.

6 If you switch apps, the timer resets.
App: Timer
This is a a timer with a pre-defined time duration.

1. In the top-center of Nextube Studio, click to open the App Library.

2. Click and drag the Timer app icon to the dock below the library.
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15



3. Inthe tray, click the Timer app icon.

Timer Settings

Timer | o m || 0s |

4. Set the Timer setting for minutes and seconds.
5. Onthe Timer Settings title bar, click X to close the dialog box.
6. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click M.
Your Nextube updates and restarts.
To use the app, when selected on your Nextube:

» A short press of the middle button starts and stops the timer.
» Along press of the middle button resets the timer.

6 If you switch apps, the timer resets.

App: Subscribe

See a live count of social media subscribers. Currently, only YouTube channels are supported.
1. In the top-center of Nextube Studio, click to open the App Library.
2. Click and drag the Subscribe app icon to the dock below the library.

3. Inthe tray, click the Subscribe app icon.

B > | Youtubechannel ID

4. Enter the Youtube channel ID.
5. With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click MM,

Your Nextube updates and restarts.

App: Alarm

Your Nextube can be used as an alarm clock with an audio alert. Up to six alarms can be added.
9 Your Nextube must be on the Alarm app at the specified time, or the alarm will not sound.

1. Inthe top-center of Nextube Studio, click to open the App Library.

2. Click and drag the Alarm app icon to the dock below the library.
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In the tray, click the Alarm app icon.

Click Add an alarm.

Alarm Settings

Alarm(24h) [ o || o |

In the Alarm Settings dialog box, enter the hours and minutes. Enter hours using a 24-
hour clock format.

Alarms can be turned on or off by toggling the control for each alarm.

If you have multiple alarms configured, you can enter a custom display name for
convenience. Click Alarm, and then in the box enter the custom name. When you click
away from the box, the entry is saved.

On the Alarm Settings title bar, click X to close the dialog box.
With the clock plugged in and connected (wired or Wi-Fi), in the upper-right, click IEZZZM.

Your Nextube updates and restarts.

To silence the alarm, press the center button.

App: Album

Display your own images on Nextube. You can add three groups of images. Each group can
contain six images (one for each tube).

Nextube supports standard image files like .gif, .jpg, and .png.

1.

November 12,2022 | v1.35
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In the top-center of Nextube Studio, click to open the App Library.
Click and drag the Album app icon to the dock below the library.

In the tray, click the Album app icon.

Click Album#1, Album#2, or Album#3.

In the Album Settings dialog box, click one of the six slots.

Select an image.

To adjust the image, click the image thumbnail and make changes in the Adjustment
dialog box. Adjust the size using the Width and Height boxes values.

Positioning can be changed with the three alignment buttons (rotate left, center, rotate
right), the Move X and Move Y boxes values, or dragging the image with your mouse
pointer.

17



8.

When you're done adding images, on the Album Settings title bar, click X to close the
dialog box.

To change the order of albums, click and drag the & icon.

To change the duration that an image is shown, click the number in Duration row.

After an image is added, it can be replaced, but the slot can’t be cleared entirely from a group.

1.

N o o > WD

Open the album.

Click the image thumbnail.

Click one of the three alignment buttons (rotate left, center, rotate right).
Click Cancel.

Click the blank thumbnail.

Select an image, make any adjustments, and then click Confirm.

On the Album Settings title bar, click X to close the dialog box.

To completely remove an image from a slot within any of the three albums, you must remove
the Album app from the dock, re-add the app to the dock, and then add images again.

November 12,2022 | v1.35
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Create custom clock style graphics

Each clock style consists multiple .jpg file format graphic files. To create the files, use any
graphics program like Microsoft Paint, Adobe Photoshop, GIMP, or Paint.NET.

6 See the Photoshop Nextube Artwork Template.psd and Template grey.jpg templates in the Facebook
group Files section. These 300x300 templates help you create .jpg images that require no scaling or
positioning adjustments in Nextube Studio.

Your images should be 80x160 pixels. For ease of importing into Nextube Studio, it's
recommended that you place the 80x160 image on a 300x300 background with the graphic
positioned 100 pixels from the top edge and 110 pixels from the left edge. See the green
guidelines in the Photoshop template or the gray area in the Template grey.jpg file below.

COPYRIGHT NOTICE Typography, fonts, and imagery are often copyrighted and highly
protected intellectual property, especially corporate branding fonts and logos. Simply
coloring or making slight adjustments can be a violation of copyright. Even “free” fonts
typically stipulate that they can be used only for non-commercial purposes and not
distributed. Don't post custom clock styles of fonts and imagery that are copyrighted or
part of a limited-use personal license, including derivative artwork.

CLOCK GRAPHIC FILES

A complete set should consist of the following folders and files:
= Numbers 0.jpg, 1.jpg, 2.jpg, 3.jpg, 4.jpg, 5.jpg, 6.jpg, 7.jpg, 8.jpg, 9.jpg
= AMPM am.jpg, pm.jpg, colon, jpg, blank.jpg

The Multilnfo folder is used with the default Clock app, not the Custom Clock app. You don’t
need to create these folders or files. They are listed below for reference only.

*  Humidity degree.jpg, humidity.jpg

» Temperature degree.jpg, degree.jpg, minus.jpg
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= Weather fewClouds.jpg, fog.jpg, overclastClouds.jpg, rain.jpg, sand.jpg, snow.jpg,
squalls.jpg, sun.jpg, thunderstorm.jpg, tornado.jpg, volcanicAsh.jpg

=  WeekDate

= date 0.jpg, 1.jpg, 2.jpg, 3.jpg, 4.jpg, 5.jpg, 6.jpg, 7.jpg, 8.jpg, 9.jpg

= week sunday.jpg, monday.jpg, tuesday.jpg, wednesday.jpg, thursday.jpg,
friday.jpg, saturday.jpg

To use your custom clock style, see the Custom clock styles section.

Share your custom clock files with Nextube Facebook group’s file library at
https://www.facebook.com/groups/197056519103446/files/docs by uploading a compressed
.zip file. Facebook doesn't allow the upload of .zip files, so change the file extension to .zipper.

Create an uploadable .zipper file on Windows 10, Windows 8, and Windows 7

1. Open File Explorer (Windows 10 or Windows 8) or Windows Explorer (Windows 7).
2. Right-click the folder that contains your custom clock style files.
3. Do one of the following:

* In Windows 11, click Compress to ZIP file.

* |n Windows 10 and Windows 8, point to Send to, and then click Compressed (zipped)
folder.

A new compressed zip folder is created and named the same as the folder, but with a
.zip extension.

4. By default, Windows hides filename extensions. If file extensions aren’t shown, you must
turn on file extensions display by using one the following steps:

* In Windows 11, on the View menu, point to Show, and then click File name
extensions.

* In Windows 10 or Windows 8, on the View tab, in the Show/hide group, select the File
name extensions check box.

5. Select the compressed zip folder, and press F2.
6. Rename the file extension from .zip to .zipper and press Enter when done editing.

A dialog box appears warning you about consequences of changing a file extension.
Click Yes to make the change.

Create uploadable .zipper files on a Mac

1. Go to Finder and find the folder containing your custom clock style files.
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2. Right-click the folder and choose Compress.

3. A new compressed zip folder is created and named the same, but with a .zip extension.

4. By default, filename extensions are hidden in macOS. Select the file, then choose File >
Get Info, or press Command-I.

5. Click the arrow next to Name & Extension to expand the section.
6. To show the filename extension, select the Hide extension check box.

7. Change .zip to .zipper, and then in the confirmation dialog box, click Use .zipper.
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Update firmware

WARNING Installing the wrong firmware or a data/power interruption during the update process can
damage your device and, at worst, permanently disable it. Only update your firmware if advised by the
manufacturer and you're comfortable doing so.

1. Download the Rotrics Nextube firmware at rotrics.com/pages/downloads. The firmware
file (firmware.bin) will be contained in a compressed .zip file. The current version as of
this writing is 1.2.1.

e
]

Software download page

2. After downloading the firmware file, you must extract the firmware.bin file from the .zip
file. Double-click the .zip file. You can then either drag the firmware.bin file to your
computer’s desktop, or another convenient folder, like Downloads.

3. In the upper-right of Nextube Studio, click EXZS.
4. Click the General dropdown list.

Your Nextube firmware, software, and hardware version appears. If you downloaded a
later version firmware version in step 2 above, you may update your Nextube.

5. Click Update next to the firmware entry, and then select the file (firmware.bin) that you
downloaded.

Wait for the update to complete.

& WARNING Don't disconnect the USB cable or shut down your computer until the firmware
update process completes.

There will not be a version listed after the firmware update is complete like the current
v0.0.2 that appears in the software. If you uploaded the master firmware file folder and
not the internal file, your Nextube will go black and must restart.
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Troubleshoot Nextube and Nextube Studio

Why can’t | use a USB-C to USB-C cable?

The wrong cable probably won’t work. The e e e e e e e e
USB Type-C specification describes how a [a] (pu-] feue] [ecs] [0 ] [o- ] [soua] frous] (] [ [ano]

Type-C upstream-facing port (UFP)

applies Pull-Down resistors (Rg) on ‘ el ’
Configuration Channel pins CC1 and CC2

to signify that it's a device and the Type-C (2] fous] fsowe] (-] [ ] [cc2] frows] o] o] [coo]
downstream-facing port (DFP) is required mEmREREIERERES

to have Pull-Up resistors (R,) on CC1 and CC2. Without these resistors the “host” won't

recognize the device and send power. It appears that Nextube isn't a true USB-C device, but only
a device using a USB-C connector.

If you have a computer that only has USB-C ports, use a USB-C to USB-A adapter.

One or more of the displays/rear LEDs aren’t working

= Make sure you are using the USB-A charger and cable that came with your Nextube. You
can also try another known-good USB-A charger and/or USB-A to USB-C power cable.

» Verify that the display boards are firmly seated in the circuit board sockets.
1. Unplug your Nextube from the USB-A charger.
2. Gently twist and pull the glass covers out of the brass holder.

3. The display module boards can be removed and inserted like a USB thumb drive.
Make sure you note the direction the LED faces (toward the back).

Image courtesy Rotrics

Note: Although this illustration shows the circuit board without the case, you don’t need to remove.
4. Reconnect your Nextube with the USB-A charger.

If the display modules are firmly seated and you still encounter issues, unfortunately, you're
going to need a replacement of the display module, the base, or both.
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To further troubleshoot which part is defective, carefully try swapping the bad display
modules with a good one. This helps you identify whether the problem is the display
module or the circuit board.

You must contact Rotrics for assistance or a replacement. There is no other source for parts.

How can | make my Nextube not move around so easily?

Peel off the plastic coverings on the two white anti-skid pads on the bottom of your Nextube.

What happens if the Update stops at 99%?

If this happens, try the following:

1.
2.
3.

4.
5,

Click L= Connect, and then Disconnect.
Close Nextube Studio.

Power cycle your Nextube by removing cable from the rear USB-C connector, waiting 10
seconds, and then reconnecting power.

Restart Nextube Studio.

Click the =l Connect button and reconnect via Serial Port or Wi-Fi.

If the problem continues, try removing or adding an app.

1.

N o o &~ w

Close Nextube Studio.

Power cycle your Nextube by removing cable from the rear USB-C connector, waiting 10
seconds, and then reconnecting power.

Restart Nextube Studio.

Click the B3 Connect button and reconnect via Serial Port or Wi-Fi.

In the top-center of Nextube Studio, click [lESM to open the App Library.
Click and drag an app icon to the dock below the library.

Click Upload.

How do I reset the Wi-Fi information on Nextube to factory default (AP mode)?

1.

Using the supplied USB-A to USB-C cable, connect your Nextube to the supplied USB
power adapter and plug the power adapter into an electrical outlet.

Long press the left button for two seconds until you hear a beep.
Quick press the middle button twice. You should hear a beep.
Your Nextube will restart.

Repeat the initial connection configuration. See the Initial connection setup section.
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Why does my Nextube continue to show the wrong local time?

Your Nextube clock is calibrated automatically by using NTP (network time protocol) and a RTC
(real time clock) chip. The time synchronizes to the local time after about 30 seconds to 5
minutes, after you've completed the Initial connection setup steps.

If the clock is wrong, the most likely problem is that your Nextube can’t connect to the Internet
and establish a connection to a NTP server.

1. Check your Wi-Fi credentials in Nextube Studio. Even if you're updating Nextube via the
USB connection method, Nextube uses your Wi-Fi network to connect to the Internet.
The Wi-Fi network name and password are both case-sensitive.

2. Make sure your Nextube is connected to a 2.4 GHz Wi-Fi network. The newer 5 GHz Wi-Fi
networks aren’t supported.

Why is the time no longer accurate (off slightly)?

The Wi-Fi connection of Nextube might go offline when left alone for longer periods of time. The
device’s Wi-Fi connection is required to keep the clock time accurate.

= Power cycle your Nextube by removing cable from the rear USB-C connector, waiting 10
seconds, and then reconnecting power.

This should re-activate the Nextube’s Wi-Fi connection. If the time doesn’t correct within a few
minutes, proceed to the following steps:

1. Close Nextube Studio.

2. Power cycle your Nextube by removing cable from the rear USB-C connector, waiting 10
seconds, and then reconnecting power.

3. Restart Nextube Studio.

4. Click the =l Connect button and reconnect via Serial Port or Wi-Fi.

5. In the top-center of Nextube Studio, click IlEEM to open the App Library.
6. Click and drag an app icon to the dock below the library.

7. Click Upload.

The time won’t update immediately, but should correct within a few minutes.

How do | adjust the clock for going to/from daylight saving time/summer time?

Try the steps in the Why is the time no longer accurate section above. Those steps address
multiple possible time issues, including restoring the Nextube Wi-Fi connection, time accuracy,
and time offset.
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Why is my Nextube stuck in a reboot?
One of the common causes of a reboot loop is a malformed custom clock style.

To correct this, you can either:

= Connect your Nextube to your computer with a USB connection, and then in Nextube
Studio, remove the display style you added, and then click Upload.

= Reset your Nextube to default AP mode and then set up again using the steps in the
Initial connection setup section.

Is there a way to make my Nextube get the same IP address on my Wi-Fi network every time?

Yes. Most networks are configured to dynamically assign IP addresses. This means that when a
device requests an IP address assignment or after a pre-defined time limit, a DHCP server
assigns an IP address. Sometimes it could be the same, sometimes it could be different.

Most DHCP servers whether on a computer network or a Wi-Fi router allow you to create DHCP
reservations. This allows you to specify that when a device with a unique MAC address
connects, always assign it a specific IP address.

Each server and router are different, so please refer to your manual for more instructions.

Why are some of my changes not appearing on my Nextube?

Some customers report that changes like background LED colors don’t change when they
upload to Nextube via Wi-Fi connection. If this happens, try connecting using the wired USB
method and uploading your changes.

Where is the Rhythm Analyzer app?

Rotrics hid this function from the software because it wasn't ready for deployment. In a
Kickstarter update on July 31, 2022, Rotrics said that they intend to release the feature in the
future.

How do | make the colon not flash when using custom clock styles?

There are two images for the colon — a blank image and the image of the colon. Nextube
switches between the two images. When loading a custom clock style, select the colon image
for both blank and colon. See the Custom clock styles section for more information.

Custom Clock ([#]

A background image
for blinking colon
effect
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How can | turn off the Nextube display without disconnecting the power?

There is no power off switch or command. You could create a custom clock black with black
panels for numbers and symbols. Then, using the buttons, switch to that custom clock. Thanks
to Frank Boecherer for this tip.

How can | make a dimmer display for night, dark environments, or chill evenings?

One way is to create a custom clock with images at half or less brightness. Then, using the
buttons, switch to that custom clock. Thanks to Frank Boecherer for this tip.
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Nextube modifications

A wiki and file repository is available on GitHub that contains additional technical information
about Nextube and APls.

At this time, Rotrics hasn't released the Nextube software code or provided official developer
documentation. Modification of your Nextube is at your own risk and isn’t intended for people
who aren't comfortable working with software development and APlIs.

https://github.com/dgl/nextube/wiki
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Technical specifications

Model: NXT10B

SoC: Espressif Systems ESP32-DOWD-V3

CPU: Xtensa dual-core 32-bit LX6 microprocessors, wafer version 3, 240 MHz
Flash: 16 MB

Bluetooth: v4.2 BR/EDR and BLE specifications

Wi-Fi: 802.11 b/g/n (2.4 GHz)

Power: 3.3V DC
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